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Introduction

The Level TROLL Instrument is a compact, modular system for measuring level and
temperature in natural groundwater, surface water, industrial waters, and other

installations.

Scope

This document is intended to describe the characteristics, operation, calibration, and
maintenance of the instrument. Communication registers and SDI-12 programming
information can be found in the Modbus and SDI-12 Reference Guides on the In-Situ

Inc. website.

Serial Number Location

The serial number is engraved on the instrument housing. It is also programmed into
the instrument and is displayed when the instrument is connected to a computer

running Win-Situ Software.

Certification

See the Declarations of conformity at end of this manual.

Unpacking and Inspection

Your instrument was carefully inspected before shipping. Check for any physical
damage sustained during shipment. Notify In-Situ and file a claim with the carriers
involved if there is any shipping damage. Accessories may be shipped separately and
should also be inspected for physical damage and the fulfillment of your order.

Please save packing materials for future storage and shipping.
The shipping boxes have been performance-tested and provide
protection for the instrument and its accessories.

Warranty

See the product specification tables for warranty information.

Contact Information

Mailing and Shipping

Address: Phone: 970-498-1500 (international & domestic)

In-Situ Inc. Fax: 970-498-1598

221 East Lincoln Avenue Int ¢ in-sit

Fort Collins, CO 80524 nternet: www.in-situ.com

U.S.A. Support: 800-446-7488 (U.S.A. & Canada)
1-800-446-7488 7 www.in-situ.com



Product Specifications

Level TROLL 400 Instrument

General

Level TROLL 400

Temperature ranges'’

Operational: -20-80° C (-4-176° F)
Storage: -40-80° C (-40-176° F)
Calibrated: -5-50° C (23-122° F)

Diameter 1.83cm (0.72in.)

Length 21.6cm(8.5in.)

Weight 197 g (0.43 Ib)

Materials Titanium body; Delrin nose cone
Output options Modbus/RS485, SDI-12, 4-20 mA
Battery type & life2 3.6 V lithium; 10 years or 2M readings
External power 8-36 VDC

Memory 2.0 MB

Data records3 130,000

Data logs 50

Log types Linear, Fast Linear, and Event

Fastestlogging rate &
Modbus rate

2 per second

Fastest SDI-12 & 4-20 mA
output rate

1 per second

Real-time clock

Accurate to 1 second/24-hr period

Sensor Type/Material

Piezoresistive; titanium

Calibrated Range
(Usable Depth)

Absolute (non-vented)
30 psia (11 m, 35 ft)

100 psia (60 m, 197 ft)
300 psia (200 m, 658 ft)
500 psia (341 m, 1120 ft)

Burst pressure

Max. 2x range; burst > 3x range

Accuracy @ 15° C4

+0.05% full scale (FS)

Accuracy (FS)°

+0.1% (FS)

Resolution

+0.005% FS or better

Units of measure

Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmH20, inH20
Level:in, ft, mm, cm, m

Temperature Sensor

Accuracy & resolution

+0.1° C; 0.01° C or better

Units of measure

Celsius or Fahrenheit

Warranty SULES
Up to 5-year extended warranties are available for all instruments—call for details
1 Temperature range for non-freezing liquids
2 Typical battery life when used within the factory-calibrated temperature range
3 1 data record = dateftime plus 2 parameters logged (no wrapping) from device within
the factory-calibrated temperature range
Footnotes

4 Across factory-calibrated pressure range

5 Across factory-calibrated pressure and temperature ranges
Specifications are subject to change without notice.
Delrin is a registered trademark of E.I. du Pont de Nemours and Company.

1-800-446-7488
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Level TROLL 500 Instrument

General

Level TROLL 500

Temperature ranges'’

Operational: -20-80° C (-4-176° F)
Storage: -40-80° C (-40-176° F)
Calibrated: -5-50° C (23-122° F)

Diameter 1.83cm (0.72in.)

Length 216cm(8.5in.)

Weight 197 g (0.43 Ib)

Materials Titanium body; Delrin nose cone
Output options Modbus/RS485, SDI-12, 4-20 mA

Battery type & life2

3.6 V lithium; 10 years or 2M readings

External power

8-36 VDC

Memory 2.0 MB

Data records3 130,000

Data logs 50

Log types Linear, Fast Linear, and Event

Fastestlogging rate & Modbus rate

2 per second

Fastest SDI-12 & 4-20 mA output rate

1 per second

Real-time clock

Accurate to 1 second/24-hr period

Sensor Type/Material

Piezoresistive; titanium

Calibrated Range
(Usable Depth)

Gauged (vented)

5 psig (3.5 m, 11.5 ft)

15 psig (11 m, 35 ft)

30 psig (21 m, 69 ft)

100 psig (70 m, 231 ft)
300 psig (210 m, 692 ft)
500 psig (351 m, 1153 ft)

Burst pressure

Max. 2x range; burst > 3x range

Accuracy @ 15° C4

+0.1% FS

Accuracy (FS)°

+0.05% FS

Resolution

+0.005% FS or better

Units of measure

Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmHZO, inHZO

Level: in, ft, mm, cm, m

Temperature Sensor

Accuracy & resolution

+0.1° C; 0.01° C or better

Units of measure

Celsius or Fahrenheit

Warranty OVEETD
Up to 5-year extended warranties are available for all instruments—call for details
Footnotes See See page 8.

1-800-446-7488
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Level TROLL 700 Instrument

General

Level TROLL 700

Temperature ranges'

Operational: -20-80° C (-4-176° F)
Storage: -40-80° C (-40-176° F)
Calibrated: -5-50° C (23-122° F)

Diameter 1.83cm (0.72in.)

Length 21.6cm(8.5in.)

Weight 197 g (0.43 Ib)

Materials Titanium body; Delrin nose cone
Output options Modbus/RS485, SDI-12, 4-20 mA

Battery type & life2

3.6 V lithium; 10 years or 2M readings

External power

8-36 VDC

Memory 4.0 MB

Data records? 260,000

Data logs 50

Log types Linear, Fast Linear, Linear Average, Event, Step Linear, True Logarithmic

Fastest logging rate & Modbus rate

4 per second

Fastest SDI-12 & 4-20 mA output rate

1 per second

Real-time clock

Accurate to 1 second/24-hr period

Sensor Type/Material

Piezoresistive; titanium

Calibrated Range
(Usable Depth)

Absolute (non-vented)

30 psia (11 m, 35 ft)

100 psia (60 m, 197 ft)
300 psia (200 m, 658 ft)
500 psia (341 m, 1120 ft)
1000 psia (693 m, 2273 ft)

Gauged (vented)

5 psig (3.5 m, 11.5 ft)

15 psig (11 m, 35 ft)

30 psig (21 m, 69 ft)

100 psig (70 m, 231 ft)
300 psig (210 m, 692 ft)
500 psig (351 m, 1153 ft)

Burst pressure

Max. 2x range; burst > 3x range

Accuracy @ 15° C4

+0.05% FS

Accuracy (FS)®

+0.1% FS

Resolution

+0.005% FS or better

Units of measure

Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmH2O, inH2O

Level:in, ft, mm,cm, m

Temperature Sensor

Accuracy & resolution

+0.1° C; 0.01° C or better

Units of measure

Celsius or Fahrenheit

Warranty O PEEI
Up to 5-year extended warranties are available for all instruments—call for details
Footnotes See See page 8.

1-800-446-7488
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Level TROLL 700H Instrument

Comply with the Office of Surface Water by using the most accurate pressure
transducer available. The Level TROLL 700H meets the surface-water specification of

+0.01 foot.

For accuracy under all operating conditions, instruments are calibrated over the full
pressure and temperature range. Each instrument includes a serialized, NIST-traceable

calibration report.

General

Level TROLL 700H

Temperature ranges'

Operational: -20-80° C (-4-176° F)
Storage: -40-80° C (-40-176° F)
Calibrated: 0-40° C (32-104° F)

Diameter 1.83cm (0.72in.)

Length 21.6cm(8.5in.)

Weight 197 g (0.43 Ib)

Materials Titanium body; Delrin nose cone
Output options Modbus/RS485, SDI-12, 4-20 mA
Battery type & life2 3.6 V lithium; 10 years or 2M readings
External power 8-36 VDC

Memory 4.0 MB

Data records3 260,000

Data logs 50

Log types Linear, Fast Linear, Linear Average, Event, Step Linear, True Logarithmic

Fastest logging rate & Modbus rate

4 per second

Fastest SDI-12 & 4-20 mA output rate

1 per second

Real-time clock

Accurate to 1 second/24-hr period

Pressure Sensor Type/Material

Piezoresistive; titanium

Calibrated Range
(Usable Depth)

Gauged (vented)
15 psig (11 m, 35 ft)

Burst pressure

Max. 2x range; burst > 3x range

Accuracy®

10.01 footup to 10 ftand £0.1% of reading > 10 ft

Resolution

+0.005% FS or better

Units of measure

Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmHZO, inH20
Level: mm, cm, m, in, ft,

Temperature Sensor

Accuracy & resolution

+0.1° C; 0.01° C or better

Units of measure

Celsius or Fahrenheit

Warranty 3 years
Up to 5-year extended warranties are available for all instruments—call for details
Footnotes See See page 8.

1-800-446-7488
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BaroTROLL Instrument

The titanium BaroTROLL measures and logs barometric pressure and temperature.

Use the BaroTROLL in conjunction with non-vented In-Situ Instruments.

Win-Situ BaroMerge Software simplifies post-correction of water level data by
automatically subtracting barometric readings from data collected by a non-vented
instrument to compensate for changes in pressure due to barometric fluctuations.

General

BaroTROLL

Temperature ranges'’

Operational: -20-80° C (-4-176° F)
Storage: -40-80° C (-40-176° F)
Calibrated: -5-50° C (23-122° F)

Diameter 1.83cm (0.72in.)

Length 216cm(8.5in.)

Weight 197 g (0.43 Ib)

Materials Titanium body; Delrin nose cone
Output options Modbus/RS485, SDI-12, 4-20 mA

Battery type & life2

3.6 V lithium; 10 years or 2M readings

External power

8-36 VDC

Memory 1.0 MB

Data records3 65,000

Data logs 2

Log types Linear
Fastestlogging rate & Modbus rate |1 per minute

Fastest SDI-12 & 4-20 mA output rate

1 per second

Real-time clock

Accurate to 1 second/24-hr period

Sensor Type/Material

Piezoresistive; titanium

Calibrated Range
(Usable Range)

30 psia (usable up to 16.5 psi, 1.14 bar)

Burst pressure

Vacuum/over-pressure above 16.5 psi damages sensor

Accuracy @ 15° C*4 +0.1% FS
Accuracy (FS)? +0.2% FS
Resolution 10.005% FS or better

Units of measure

Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmH20, inH20

Temperature Sensor

Accuracy & resolution

+0.1° C; 0.01° C or better

Units of measure

Celsius or Fahrenheit

Warranty STEETD
Up to 5-year extended warranties are available for all instruments—call for details
Footnotes See See page 8.

1-800-446-7488
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RuggedCable System

General

RuggedCable System

Operating temp. range

-25°t0 80° C (-13°to 176° F)

Jacket options

TPU (thermoplastic polyurethane)
Tefzel (ETFE fluoropolymer; generic equivalent to Teflon)

Vent options

Non-vented (absolute)

Vented (gauged) with desiccant (used to mitigate moisture/humidity)

Conductors

6 conductors, 24 AWG, polypropylene insulation

Cable diameter

TPU: 6.7 mm (0.265 in.)
Tefzel: 6.35 mm (0.25 in.)

Connector diameter

18.5mm (0.73in.)

Weight

Non-vented, TPU: 16 kg/300 m (35.6 1bs/1,000 ft)
Non-vented, Tefzel: 14 kg/300 m (32 Ibs/1,000 ft)
Vented, TPU: 14 kg/300 m (32 Ibs/1,000 ft)
Vented, Tefzel: 14 kg/300 m (32 Ibs/1,000 ft)

Minimum bend radius

2X cable diameter (13.5 mm; 0.54 in.)

Break strength

127 kg (280 Ibs)

Maximum cable length

1,219 m (4,000 ft) for RS485

Desiccant pack
(required for vented
systems)

Large and extra large desiccant packs available with titanium, ABS, or stripped-and-tinned

termination.

Warranty

2 years

Suspension Wire

Specifications are subject to change without notice.

General Suspension Wire

Material 304 stainless steel, 7 x 7 strand

Coating 15 mil polyester elastomer insulation
Weight 0.28 kg /30 m (0.60 Ib / 100 ft)

Break strength 122 kg (270 Ib) with proper clip tightening

Specifications are subject to change without notice.

1-800-446-7488
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About the Pressure/Level Sensor

A pressure transducer senses changes in pressure, measured in force per square unit
of surface area, exerted by water or other fluid on an internal media-isolated strain
gauge. In-Situ Inc. offers instruments with either absolute (non-vented) or gauged
(vented) pressure sensors.

The "Absolute vs. Gauged: Comparing Absolute and Gauged
Pressure Sensors" technical note describes the difference

& between absolute and gauged pressure sensors and explains the
proper use of each type of sensor in different applications. See
www.in-situ.com/technical_notes.

Absolute Pressure Sensor

An absolute or non-vented pressure sensor measures all pressure forces detected by
the strain gauge, including atmospheric pressure (PATM). The unit of measure is PSIA
(pounds per square inch absolute), measured with respect to zero pressure. The back
of an absolute pressure sensor is sealed from the atmosphere. Therefore, the front of
the absolute pressure sensor responds to both atmospheric pressure and the pressure
head of water above the sensor.

= PATM
(e.9., 14.5 psi)

Absolute Sensor

1 Sensor back

Sensor front

Water pressure, PW (e.g., 20 PSI)

2
3
4 Atmospheric pressure PATM (e.g., 14.5PSI)
5

Vacuum

Gauged Pressure Sensor

A gauged or vented pressure sensor eliminates the effects of atmospheric pressure
because the vent tube in the cable allows atmospheric pressure to be applied to the

1-800-446-7488 14 www.in-situ.com



back of the sensor. The unit of measure is PSIG (pounds per square inch gauge),
measured with respect to atmospheric pressure.

(e.g., 14.5psi)

i Py
{e.g., 20 psi)

— Patm
{e.q.. 14.5 psi)

Gauged Pressure Sensor

1

Sensor back

Sensor front

Water pressure, PW (e.g., 20 PSI)

Atmospheric pressure PATM (e.g., 14.5PSI)

2
3
4
5

Atmospheric pressure PATM (e.g., 14.5PSI)

BaroTROLL Atmospheric Pressure Sensor

Barometric pressure applies a direct stress upon open wells and surface water. Locally,
barometric effects can change significantly from location to location as a result of
topographical and micro-meteorological changes. Therefore, it is important to
compensate for the barometric pressure changes when monitoring water elevation.

= PATM
(e.g., 14.5 psi)

BaroTROLL Sensor

Sensor back

Sensor front

Atmospheric pressure PATM (e.g., 14.5PSI)

AT OWOW|IDN

Vacuum

1-800-446-7488 15
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Configuring Depth and Level for PLC or Data Logger

When you configure level using the Sensors tab, the settings are stored in the
instrument and are available for use in Modbus, SDI-12, or 4-20 mA analog
communication. A different configuration can be selected when you set up a log.

1. Connect the instrument to the software.

2. Click the Sensors tab _&

3. Select the level/pressure sensor and click the Configure [wua s button. The
Sensor Setup window appears.

Sensor Setup o ll

Parameter:

Configure. .. |

Sentinel Offline Values:

|D‘DDD

4. Inthe Sensor Setup window, select the Level parameter, then click Configure The
Level Setup Wizard opens.

Logging Setup Wizard . (=l
What do you want the output to be?
[ el Ground Water
# peoy
v € Depth to Water(DTW)Drawdown
" Elevation
+ Surface Water
Depth " Depth
"~ Gauge HeightStage
- " Elevation
Q Use ko measure amount of head or water height over sensor.

_@E@.ﬂ:_ﬁ.m

5. In the Level Setup Wizard, select the options you want. For more information, view
the Help in the Win-Situ 5 Software.

1-800-446-7488 16 www.in-situ.com



System Components

Instrument

The Level TROLL Instrumentis completely sealed and contains no user-serviceable
parts. The instrument includes pressure and temperature sensors, a real-time clock,
microprocessor, sealed lithium battery, data logger, and memory. Options include a
vented or non-vented pressure sensor in a variety of ranges.

RuggedCable System

RuggedCable Systems are custom-built, durable, direct-read cables that include the
following items.

« Titanium twist-lock connectors for quick, reliable connections to the instrument,
desiccant, and communication cable

» Metal shield beneath the cable jacket to prevent electrical interferences
« Kellems grip for secure instrument deployment

« Small desiccant for vented systems (for storage only)

& Non-vented cables are marked with VF, which means vent free.

Vented or Non-Vented Cable

Vented cable is used with vented pressure sensors to produce gauged measurements.
The cable vent tube ensures that atmospheric pressure is applied to the back of the
sensor diaphragm.

Non-vented cable is used with non-vented instruments for absolute measurements.
Compensate absolute measurements by using a BaroTROLL Instrument and Win-Situ
Baro Merge Software.

& Vented cable is shipped with a small desiccant to protect against
condensation. Larger desiccants are necessary for deployment.

Jacket Options

Tefzel (vented) or thermoplastic polyurethane (TPU, vented or non-vented)
Customizable Cable Lengths

Cables can be ordered up to 1,219 m (4,000 ft).

Cable Termination

Cables can be ordered with a twist-lock termination (female connector) on both ends
that connect to the instrument, the TROLL Com Communication Device, desiccant, and

1-800-446-7488 17 www.in-situ.com



other accessories.

Cables can also be ordered with stripped-and-tinned termination for wiring to a data
logger or controller using SDI-12, analog (4-20 mA), or Modbus communication
protocol.

e

N

1 RuggedCable System with female to female connectors

2 Stripped-and-tinned RuggedCable System with female connector

Stripped-and-tinned RuggedCable System with male connector
3 (short length that converts a cable with a twist-lock connector to a
stripped-and-tinned cable)

1-800-446-7488 18 www.in-situ.com



Suspension Wire

Polyurethane-coated stainless steel suspension cable can be used to deploy
instruments with non-vented pressure sensors such as the Level TROLL 400
Instrument, the non-vented Level TROLL 700 Instrument, and the BaroTROLL

Instrument. Suspension wire is appropriate to use when direct communication with the
instrument is not necessary during deployment.

Description Part Number
Suspension Wire - 300 feet 0066450
Suspension Wire - 150 feet 0066460
Suspension Wire - 50 feet 0066470
1-800-446-7488 19 www.in-situ.com



Communication Cables

The TROLL Com Communication Device provides an interface between the instrument
and a desktop/laptop PC or the RuggedReader Handheld PC for calibrating and
programming the instrument and for profiling and downloading data. The TROLL Com
Communication Device is offered in either a cable-connect or direct-connect
configuration including a 0.9 m (3 ft) vented polyurethane cable, external power input
jack, and vent with replaceable membrane.

Cable-Connect TROLL Com Communication Device

The Cable-Connect TROLL Com Communication Device connects to an instrument's
RuggedCable System and to a serial or USB port. This communication cable is
weatherproof and withstands temporary immersion in water (IP67 compliant).

RS232 TROLL Com, Cable-Connect, part number 0056140 (pictured) or USB
TROLL Com, Cable-Connect, part number 0052500

2 | External power input

3 | Vent

4 | Twist-lock connector
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Direct-Connect TROLL Com Communication Device

The Direct-Connect TROLL Com Communication Device connects directly to an
instrument and to a serial or USB port. This option is intended for programming a non-
vented instrument that will be deployed without a RuggedCable System.

RS232 TROLL Com, Direct-Connect, part number 0056150, or USB TROLL Com,
Direct-Connect, part number 0052510 (pictured)

2 | External power input

3 | Vent

4 | Snap-on connection to instrument
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Power Options
Internal Power—Batteries

Internal batteries are not user-replaceable. The approximate percentage of the power
remaining in an internal battery is displayed on the Home Screen when an instrument is
connected to Win-Situ Software.

The instrument is powered by 3.6 VDC, supplied by a sealed, non-replaceable AA
lithium battery. Battery life depends on sampling speed. The battery typically lasts for
10 years or 2,000,000 readings, whichever occurs first.

When an instrument is wired to a data logger or PLC controller, power to the instrument
is supplied by the data logger or controller.

AC Adapter

The AC adapter provides 24 VDC, 0.75 A, AC input 100-250 V and includes a North
American power cord. The TROLL Com Communication Device includes an external
power input port for connection to the AC adapter.

Description ‘ Part Number

AC Adapter 24 VDC ‘ 0052440

Use only In-Situ Inc.'s AC adapter. Damage to the instrument
& caused by the use of third-party converters is not covered by the
warranty.

External Power—External Battery Packs

External battery packs can significantly increase the life of an instrument, either for
long-term deployments or to preserve an aging instrument.

TROLL Battery Pack

The sealed, submersible TROLL Battery Pack supplements internal battery power
when an instrument is used for fast, frequent sampling or during long-term deployments.
When this power source is connected, the instrument will use the external battery
source first and switch to the internal batteries when external battery power is depleted.
Total battery life depends on the sampling speed.

P <

Description ‘ Part Number

TROLL Battery Pack ‘ 0051450
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The sealed, submersible TROLL Battery Pack supplies 14.4 V. When this power
source is connected, the Level TROLL will use the external battery source first and
switch to the internal batteries when external battery power is depleted.

0.5 second sampling interval 1.2 months

1 second sampling interval 2.3 months

1 minute (or longer) sampling interval | 1 year

TROLL Replaceable Battery Pack

The TROLL Replaceable Battery Pack supplements internal battery power when a
Level TROLL or Aqua TROLL 100 or 200 Instrument is used for frequent, fast sampling
or during long-term deployments. When this power source is connected, the TROLL
instrument will use the external battery source first and switch to the internal batteries
when external battery power is depleted. Battery life depends on sampling rate. This
battery pack allows for 1.5 V UM-3 or size AA batteries (8) that are replaced by the user.

v The TROLL Replaceable Battery Pack is not submersible.

TROLL® Replaceable Batery Pack

22 In-Situlnc.
221 E Lancoirr Fornt Colbne ©0 BOS24

Description ‘ Part Number

TROLL Replaceable Battery Pack ‘ 0090000
Estimated Battery Lifetime

TROLL Battery Pack |Level TROLL Family

15 minute logging

rate* 1.1 years

1 hour logging rate* 1.1 years

*Logging with all sensors. Actual battery lifetime varies based on site conditions.

TROLL Replaceable |, . | TROLL Family

Battery Pack

15 rzunute logging 16 years
rate

1 hour logging rate* 1.7 years

*Logging with all sensors. Actual battery lifetime varies based on site conditions.
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Installation Accessories
NPT Adapter
The 0.25 in. NPT adapter allows instrument installation in piping.

Part Number ‘ Image ‘ Description

0051470 ﬂ NPT Adapter

Cable Extender

The cable extender connects two lengths of RuggedCable System to meet varying
installation needs.

Description Image Part Number

Cable Extender 0051490

Twist-Lock Hanger

The Twist-Lock Hanger is used with a suspension wire to install a non-vented
instrument when the user does not require direct communication.

Part Number |Image Description

Twist-Lock Hanger, titanium
for Level TROLL 500, 700,
700H, BaroTROLL

0051480
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Bulkhead Connector

The panel-mounted bulkhead connector provides connection between RuggedCable
System and a controller panel.

Part Number

Image

Description

0053240

Locking Well Cap

Description

<

Part Number

Bulkhead Connector

Locking Well Cap, 2"

0020360

Locking Well Cap, 2" vented 0020370

Locking Well Cap, 4"

0020380

Locking Well Cap, 4" vented 0020390

1-800-446-7488
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Well Dock Installation Ring

The well dock installation ring provides installation support for 2", 4", and 6" well
casings.

- T T S

Description Part Number

Well Dock Installation Ring 2" | 0004690

Well Dock Installation Ring 4" | 0004700

Well Dock Installation Ring 6" | 0020650
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RuggedReader Handheld PC

The RuggedReader Handheld PC is a multi-purpose, field-ready computer designed
for Windows Mobile operating systems.

Win-Situ Mobile Software provides the features of Win-Situ 5 Software on the
RuggedReader.

Description Part Number
RuggedReader Only (520 MHz) - RuggedReader only (does not
. o 0057710
include software or communications cable)
RuggedReader Kit (includes 520 MHz RuggedReader, Cable 0057720
Connect TROLL Com, and Win-Situ Mobile Software)
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Control Software
Win-Situ 5 Software

Win-Situ 5 Software is the control and calibration software for the Level TROLL, Aqua
TROLL, and Rugged TROLL Instruments.

Win-Situ 5 Software provides instrument control for direct readings and profiling, long-
term data logging, data downloads, data viewing, data export to spreadsheet programs,
selecting units, displaying options, and tracking battery/memory usage. Win-Situ 5 Plus
enables configuration of networks and telemetry.

Requirements

e 400 MHz Pentium |l processor
. 128 MB RAM

« 100 MB free disk space

« Internet Explorer 6.01 or higher

« Windows 2000 Professional SP4 or higher, or Windows XP Professional SP2 or
higher, or Windows Vista SP1 or higher

o CD-ROM drive, and a serial or USB communications port.
Win-Situ Mobile Software

Win-Situ Mobile Software provides the features and functions of Win-Situ 5 on a field-
portable platform.

Requirements

« In-Situ RuggedReader Handheld PC with Microsoft Windows Mobile operating
system

« Windows Mobile 5 or later
o Serial communications port

« Atleast 16 MB for data storage (SD card, CF card, or the device’s built-in non-
volatile memory).

For installation and file exchange, Windows 7 requires
Windows Mobile Device Center to be installed on the computer.
Earlier versions on Windows require Microsoft ActiveSync.
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Getting Started

This section provides an overview of the initial steps necessary to prepare the
instrument to log data.

« Selectthe appropriate TROLL Com Communication Device. This determines the
hardware connections, and may influence the software installation. The drawing
on the following page shows the function of the different TROLL Com
Communication Device models.

« Install the software.
« Connectthe hardware.

« Open the software and establish communication with the instrument.

Select a TROLL Com Communication Device

The subsequent figure shows the function and connection features of the TROLL Com
Communication Device models.

o A Direct-Connect TROLL Com might be preferred for programming an instrument
that will be deployed on a suspension cable.

« A RuggedCable System and a Cable-Connect TROLL Com are required if you
intend to communicate with the instrument while itis deployed. However, you can
program the instrument with any TROLL Com.

» A serial (RS232) TROLL Com is required for use with a RuggedReader Handheld
PC.
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1 Serial port on a PC/laptop and RuggedReader Handheld PC

Cable-Connect TROLL Com Communication Device, serial
connection, for field use

Direct-Connect TROLL Com Communication Device, serial
connection, programming only, not submersible

4 | USB porton a PC/laptop

Direct-Connect TROLL Com Communication Device, USB
connection, programming only, not submersible

Cable-Connect TROLL Com Communication Device, USB
connection, for field use
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Connecting RuggedCable Systems

Connect the Instrument to the RuggedCable

1.

Remove the protective caps from the instrument and cable. Ensure that the O-ring
on the instrument connection is clean.

Locate the flat side of each connector and notice the pins on the instrument
connector and the slots on the cable connector.

p—

Slide back the sleeve on the cable connector.

e S —

Position the instrument and cable flat edges so they will connect properly. Insert the
instrument connector firmly into the cable connector.

—

Slide the cable sleeve toward the instrument until the pin on the instrument fits into
the hole in the slot on the cable connector.

Hold the textured section of the sleeve in one hand and the instrument in the other.
Push and twist until you hear a click. The click ensures the cable and instrument are
securely attached.

Connect TROLL Com Communication Device to the RuggedCable System

1.

If a desiccant is present, remove the desiccant from the cable. Hold the textured
section of the cable connector in one hand and the desiccantin the other. Twistin
opposite directions to unlock the desiccant from the cable.
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2. Position the TROLL Com and cable flat edges so they will connect properly. Insert
the TROLL Com connector firmly into the cable connector.

.M.T)m—

3. Hold the textured section of the sleeve in one hand and the TROLL Com in the
other. Push and twist until you hear a click. The click ensures the cable and TROLL
Com are securely attached.
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Install the Software
Win-Situ 5 Software

Install Win-Situ 5 Software from the In-Situ software/resource CD or from the In-Situ
website. Click the Win-Situ 5 link, and follow the instructions to install Win-Situ 5 to your
local hard drive.

USB TROLL Com Drivers

If you are using a USB TROLL Com Communication Device, be sure to select the
option "Install USB TROLL Com Drivers" during the Win-Situ 5 installation. Two drivers
will be loaded to your hard drive, one for the USB TROLL Com, one for the USB
TROLL Com serial port.

Win-Situ Mobile Software

Win-Situ Mobile provides the features and functions of Win-Situ 5 on a field-portable
platform. The RuggedReader can be shipped with the software already installed.

To update or reinstall Win-Situ Mobile use the following procedure.

1. Install the desktop component of Win-Situ Mobile on a PC from the CD or website.
The desktop component is called the Win-Situ Software Manager, and is needed to
install Win-Situ Mobile on the RuggedReader.

2. Click the Win-Situ Mobile link and follow the instructions to install the Win-Situ
Software Manager to your local hard drive.

If using Windows 7, ensure that Windows Mobile Device Center is
installed. If using an operating system prior to Windows 7, ensure

v that Microsoft ActiveSync is installed on the desktop or laptop PC
and a Guest connection or partnership has been established
between the computers.

3. Connect the RuggedReader to the PC, establish a connection in Microsoft
ActiveSync, open the Win-Situ Software Manager, and follow the instructions to
install Win-Situ Mobile on the RuggedReader.

Win-Situ Sync Software

To synchronize log files from the RuggedReader to a PC after collecting data in the
field, install Win-Situ Sync from the CD or website.
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Field Deployment

Program the Instrument

In order to set up a log or download data, you must connect the instrument to a
computer running Win-Situ 5 Software, or a RuggedReader Handheld PC running Win-
Situ Mobile. See page 50.

Position the Instrument

Place the instrument at the desired depth. Position the instrument below the lowest
anticipated water level, but not so low that the pressure sensor range might be
exceeded at the highest anticipated water level. Refer to the tables below to determine
usable depth.

A

A BaroTROLL Instrument can be deployed with a non-vented
instrument to compensate level data for changes in atmospheric
pressure. Make sure the clocks on both instruments are
synchronized, and install the BaroTROLL in a location that will
never be submerged in water. See page 39.

Non-Vented Level TROLL Instrument

Range Effective Range Usable Depth
PSIA PSIA kPA Meters Feet
30 15.5 106.9 11 35
100 85.5 589.5 60 197
300 285.5 1968 200 658
500 485.5 3347 341 1120
1000 985.5 6795 693 2273

* Effective range for psia sensors is limited by an estimated
14.5 PSI atmospheric pressure at sea level.
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Vented Level TROLL Instrument

Range Usable Depth
PSIG kPA Meters Feet
5 34.5 3.5 11.5
15 103.4 11 35
30 206.8 21 69
100 689.5 70 231
300 2068 210 692
500 3447 351 1153

Verify Instrument Depth

After you have installed the instrument, it is possible to connect the instrument to a
computer or RuggedReader, open the software, and take a reading to verify the
installation position. If the reading confirms that the instrument is in the correct position,
you can secure it as described below.

During log setup there was an option to "Remind Me Later" for setting a level reference.
If you set the log to remind you later, ensure that the instrument is submerged and set
the level reference when prompted. See page 53.

Secure the Cable

The RuggedCable System includes a Kellems grip near the up-hole end. You can
compress the wire mesh and slide the grip to the desired location on the cable. Pull on
the grip to tighten it on the cable.

Use the loop on the Kellems grip to anchor the cable to a convenient stationary object
such as the In-Situ well dock installation ring. To install the Kellems grip to the
installation ring, insert the loop into the locking clip on the well dock and position the
assembly at the top of a well casing.
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1 Well Dock Installation Ring

N

Kellems Grip

w

Instrument Installed in Well

Install the Desiccant

& Vented cable must be protected with a desiccant pack that is
properly sized for site conditions.

Desiccant

Desiccant protects electronics from condensation, which can cause irreparable damage
and loss of data. Indicating desiccant changes from blue to pink as it becomes
saturated with moisture.

3

Desiccant stages (from left)
New, nearly expired (replace now), expired
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Itis extremely important to use a properly-sized desiccant for your deployment and to
change desiccant often. Desiccant should be changed before the entire volume has
turned pink, and you should use enough desiccant to effectively keep cables,
instruments, and electrical boards dry until your next scheduled maintenance.
Desiccant life span is dependent on site conditions.

Installation Guidelines

« Never let the instrument fall freely down a well. Doing so will damage the sensor.

« After you have installed the instrument, verify the water level reading. Move the
instrument and take another reading to ensure that the instrument shows
reasonable change. The instrument could be wedged against the well casing with
a loop of cable hanging below. An instrument in such a position could become
dislodged and move while it is logging data, which would record a false change in
the water level.

« For accurate measurements, the instrument should remain immobile while itis
logging data.

« Make sure that the uphole cable end is protected. The vented cable must be
protected with a desiccant, and the non-vented cable must be protected with a
dust cap. The uphole cable end must be positioned above the highest anticipated
water level. Avoid placing this end in a location that might flood.

« Do not deploy instruments in such a way that ice may form on or near the sensor
or cable connections. Ice formation is a powerful expansive force that can over-
pressurize the sensor or otherwise cause damage. Damage associated with ice
formation is not covered by the instrument warranty.

« Do not allow vented cable to bend enough to obstruct the internal vent tube. The
recommended bend radius is 13.5 mm (0.54 in), which is twice the cable
diameter.

R | Bend radius 13.5 mm (0.54 in)
D | Cable diameter
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Stabilization Time

After you have installed the instrument, allow it to stabilize to the environment for about
10 minutes before logging data. The T95 response time for temperature is less than 9
minutes.

A generous stabilization time is always desirable, especially in long-term deployments.
Even though the cable is shielded, temperature stabilization, stretching, and relaxing
can cause changes to readings.

If you intend to monitor water levels to the instrument's stringent
accuracy specifications, allow up to 60 minutes for the probe and
cable to stabilize to the environment.
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BaroTROLL Instrument Installation

The BaroTROLL Instrument is designed to log barometric pressure from 0 to 16.5 PSIA
(1.14 bar, 33.59 inHg) at the surface near a submerged non-vented Level TROLL
Instrument or Aqua TROLL 200 Instrument. BaroTROLL data may then be used to
correct the water level data for barometric pressure fluctuations. See page 14.

‘]
|

%

Programming the Baro TROLL Instrument

Connect the BaroTROLL to Win-Situ 5 Software and sync the clock.See page 51.
Set up a log with the same start time and sample interval as you set up in the non-
vented level instrument. See page 51.

Installation

After the BaroTROLL Instrument is programmed, install it in a protected location above
the water level near the submerged water level instrument. One installation
configuration option is shown below using a twist-lock hanger and a suspension wire.

To prevent flooding of the BaroTROLL electronics, attach the
twist-lock hanger before you install the BaroTROLL. Do not
submerge the Baro TROLL Instrument.
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1 Atmospheric pressure + water pressure (as measured by a non-vented
pressure sensor)

2 | Atmospheric pressure (as measured by the BaroTROLL)

Water pressure (as measured by a vented pressure sensor, or by
subtracting BaroTROLL data from non-vented pressure sensor data)

BaroTROLL Instrument (Do not submerge.)
Non-vented Level TROLL Instrument

[ IS w

& To merge atmospheric pressure data with water level data, See
page 57.
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Software Overview

First Screen (Data Tab)

When you open Win-Situ 5 Software, the Data tab appears. The left side of the screen
contains a file tree where you can view previously downloaded site data as well as data
you have exported to Microsoft Office Excel. The links on the right side of the screen
show where downloaded data are stored on your computer. The disconnected plug
icon in the lower-right corner of the screen indicates that the software is not yet
communicating with an instrument.

C:\Users\merowellhDocumentsiWinSitu Datal

Screen Element Definition

The disconnected plug indicates the instrument is not
m—] communicating with the software. Click to establish communication
with a connected instrument.

The connected plug indicates the instrument is communicating
m with the software. Click to disconnect the software from the
instrument.

The Home tab displays real-time readings from the instrument.
I When connection to the instrument is first established, the software
displays one reading of all available parameters in light gray.

You must click the Play button ... at the bottom of the screen
to view real-time readings.
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Screen Element

Definition

The Logging tab displays a list of logs stored in the connected
instrument. When you click the Logging tab, it can take a moment
for the software to retrieve information from the instrument. The
Logging tab is not applicable for non-logging instruments such as
the RDO PRO Probe.

The Sensors tab lists the sensors in the connected instrument,
along with their serial numbers and the dates of factory calibration
and user calibration. Use the buttons in this tab to calibrate sensors
that support user calibration and configure sensors that support
configuration.

The Device Setup tab allows access to instrument information and
settings such as instrument name, serial number, firmware version,
communication settings, diagnostics, and factory reset options.

1-800-446-7488
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Home Tab

The Home tab displays real-time readings from a connected instrument. When you first
establish communication, the software displays one reading of all available parameters
in light gray. You must click the Start button to view real-time readings.

7% Win-Situ® 5 —

File Edit View Tools Preferences Help

3 B/182012 8/16/2012 m
E]:a 92505 AM & 9:25:03 am [l

Screen Element Definition

@ The Sites button allows you to add, edit, or delete a site. Click the
drop-down arrow next to the button to view the list of sites.

The Device Memory gauge turns yellow when the internal memory

is used. Note: Non-logging instruments do not have internal
: memory, however, the gauge shows 100 percent green when power
is applied.

The Device Battery gauge turns yellow as the battery is depleted.

This example shows 80 percent of the battery remaining (green) and
20 percent used (yellow). Note: Non-logging instruments do not
have internal batteries, however, the gauge shows 100 percent
green when power is applied.
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Screen Element

Definition

The Logging Status icon:
Green—The instrument is actively logging data.

Gray—The instrument has no logs pending or running. Non-
logging instruments always show a gray status icon.

Yellow—The instrument has log data that was collected
according to specific instructions in the "Pending" or
"Suspended" state.

The Alarm icon provides additional instrument status
information.

Green—No alarms or warnings
Yellow—One or more warnings
Red—One or more alarms

Move the cursor over the alarm icon to view a description.
Click the Device Setup tab for detailed information on the
alarm or warning.

Note: Disregard the Device Reset alarm for non-logging
instruments such as the RDO PRO Probe or the Aqua TROLL
400.

By woEn §/13/2012
L 111804 AM 11:18:04 AM

System Time is displayed on the left. Device Time is displayed on
the right. Clocks are updated once every two seconds. When the
Device Time is displayed in red, it differs from the current System
Time, and should be synchronized.

The Time Sync button is used to write the current PC time to the
instrument. If you need to set the instrument clock to a time other
than the system (PC) time, use the Set Clock button on the Device
Setup tab.

Meter View shows the last known parameter values, displayed with
current units and time stamp. Readings are sized to occupy the
entire screen. This is the default display in the Home tab. If the type
is black, the readings are updating in real time.

List View is a running list of the most recent records. New readings
are continuously added to the top of the list and old readings scroll
off the bottom.

Graph View shows a real-time trend graph of the selected
parameters.

The Snapshot button records one set of readings.

1-800-446-7488

44 www.in-situ.com



Screen Element Definition

_ The Record button logs data to a CSV file that can be opened in a
A spreadsheet program. This is not the same as recording data in a
log on the instrument.

The Start/Stop button starts the display of real-time readings. The
typeface darkens, and readings are continuously updated until you
click the button again to stop. Several actions cannot be performed
A while the Start button is active (for example, you cannot change
units, configure a new log, or configure level for a pressure sensor).
This is not the same as starting a log on the instrument. Start
and stop instrument logs from the Logging tab.
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Logging Tab

The Logging tab displays a list of logs in the instrument. When you click the Logging
tab, it may take a moment for the software to retrieve information from the instrument.

& Win-Situ@ 5 =)

File Edit View Tools Preferences Help

M

4} | site | Log Hame _Type | Start Time Scheduled Stop Time | Stop Time | Status | Used Sze (Kbytes) |

\L;\j m Linear 8/30/2013 3:00:00 PM Pending 64

Log Information

Columns across the Logging screen show information about the logs in the instrument.

« Symbol—This is a graphic representation of the information in the Status
column.

« Site—The site that was specified when the log was configured.
« Log Name—The name that was entered when the log was configured.
« Type—The logging method that was selected when the log was configured.

» Start Time—For a Pending log, the scheduled start time is shown. For a Ready
log that has not yet started, this column displays “Manual.” For a Running or
Stopped log, the actual start time is shown.

« Scheduled Stop Time—For a log with a scheduled stop, the scheduled stop time
is shown. For a log without a scheduled stop time, this column is blank.

« Stop Time—For a Pending or Ready log, this column is blank. For a Running
log, the time of the last data point is shown. For a Stopped log, the actual stop
time is shown.

« Status—Each log has a specific status. See Log Status for details.
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» Used Size—Kilobytes of instrument memory allocated for this log. For a Pending
or Ready log, the current size of the log configuration is shown. For a Completed
log, the size of the entire log file is shown. For a Running log, the current size of
the log up to the last data point is shown.

Log Status

The status of each log in the instrument is displayed in the Logging tab by a symbol
beside the log name, and in the Status column.

" Ready—Manual Start log is ready to start.

E;},;;-Pending—Scheduled start log is ready to start at its programmed time, or when you
click the Start button.

[I.E;L Running—The log is actively logging data.
'_"_LﬁUSuspended—The log has been paused (stopped temporarily).

‘3:?7 Stopped—The log has been stopped, either manually or on a schedule.

‘,_fﬁ Deleted—The log has been marked for deletion and will be deleted from the
instrument when memory is needed. The software manages this automatically.

'_\'%Invalid—The log as programmed cannot be run.

Ready, Pending, Running, and Suspended logs are
considered active. Only one log can be active in the instrument.

Log Control Buttons

You can control the status of a log by selecting the log and clicking the appropriate
button in the Logging tab control panel:

& The Start button starts a Ready or Pending log, or resumes a Suspended log.
i, The Pause button pauses a Running log allowing you the option to resume it.

2 The Restart button restarts the selected Running log from the beginning. This can
be useful during aquifer testing using a logarithmic data collection schedule.

& The Stop button permanently stops the selected Running log.
Log Operations
Use the buttons in the control panel to perform the following actions:
LB Create a new log.
The New button is disabled if a Ready, Pending, Running, or Suspended log is on the

instrument. When the instrument contains its maximum number of logs, the New button
is unavailable.

wlE Edit (or review) the log configuration for a Ready, Pending, or Invalid log.

_;ELW Delete the log. (Note that you must delete a log twice before it is permanently
removed.)

.¥ .. Download the logto a PC.
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Sensors Tab

The Sensors tab lists the sensors in the instrument, along with their serial numbers and
calibration dates. Use the buttons in this tab to calibrate and configure sensors.

Calibrate

Use the Calibration button to calibrate sensors or to adjust a level reference that is
currently stored on the instrument. The Calibrate button is not available when the
instrument does not support calibration (e.g. BaroTROLL Instrument).

1. With the instrument connected to the software, select the Sensors tab.

2. Select the parameter you intend to calibrate.
3. Click the Calibrate button

e’
Configure

Use the Configure button to select parameter units and to configure parameters that
support configuration. Examples include Level/Depth, Specific Conductivity, and Total
Dissolved Solids. Parameters cannot be configured while the instrument is showing
live data on the Home screen or while the instrument contains an active log.

1. With the instrument connected to the software, select the Sensors tab.

2. Select the parameter you intend to configure.

3. Click the Configure button fuat .

When you configure the Level parameter using the Sensors tab,
v the settings are stored in the instrument and are available for use

in Modbus, SDI-12, or analog communication. If desired, a

different configuration can be selected when setting up a log.
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Device Setup Tab

In general, you should not use the Device Setup tab unless you are corresponding with
the In-Situ Inc. technical support team. However, you can use this screen to set up
communication protocols if you are connecting the instrument to a PLC or data logger.

8 win-situ® 5
Fle Edit View Tools Preferences Help

2072012 £/20/2012
157132 AM “11:57:27 AM

—Device Information —Device Status

MName: ILaveI TROLL 1 =] Sensor High Power Management:
Manufacture Date: I 11/5/2008 | Set Name I [ Sensor Low

Status:
Firmware Version: I 2.02 =1 Sensor Calibration

Hardware Version: i =1 Sensor Malfunction External Power:
Mone
Boot Version: 111 =1 Hardware Reset

= Device Malfunction

— (L Tty Disable Power Management |
8/20/2012 11:57:27 AM =
120/ j I =] Set Clock | 1 Low Memory Clear Status |

—Device Firmware Update
. . Factory Reset
Available Firmware Versions
Update

Level TROLL 500 v2.02 4| e e
Analog Setup... SI12Setup.. |  ModbusSetwp.. |  AarmSetp... Go Offine

—Manual Time Set

v See the online Help for more details.
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Using Win-Situ 5 Software

Connecting an Instrument to the Software

When you open Win-Situ 5 Software, you are asked if you want to connect to your
device. Click Yes. Synchronize the instrument clock to the PC clock. | g,

Parameters and measurements are displayed in light gray on the home screenifa
connection is established. Click the Play button = to view live readings.

The software displays an error message if a connection cannot be established.

Selecting the Correct COM Port

If you are using a USB TROLL Com, select the correct COM port by following the steps
below. If you are using a serial TROLL Com, the Win-Situ Software should default to
the correct COM port, which is usually COM 1.

Steps for Windows 8 systems.

Right-click the Start screen.
Select All Apps.

Click Control Panel.

Open the Device Manager.

Click the arrow next to Ports (Com and LPT), and locate the USB Serial Port
listing. The number listed next to this entry is your COM port address.

o M 0N~

Steps for Windows 7 systems.

1. Minimize the Win-Situ Software.

2. Click the Windows Start button, and open the Control Panel.
3. Click Hardware and Sound, and open the Device Manager.
4

. Click the arrow next to Ports (COM and LPT), and locate the USB Serial Port
listing. The number listed next to this entry is your COM port address.

Steps for Windows XP systems.

1. Minimize the Win-Situ Software.
2. Click the Windows Start button, and open the Control Panel.

3. Double-click the System icon. Click the Hardware tab, and open the Device
Manager.

4. Click the plus sign next to Ports (COM and LPT), and locate the USB Serial Port
listing. The number listed next to this entry is your COM port address.

The following steps apply for all Windows operating systems.
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1. Once you have determined the correct COM port address in your operating system,
reopen Win-Situ 5 Software.

Close any open windows in Win-Situ Software.
Click Preferences.

Click Comm Settings, and then click the Port Number menu.

a &~ 0D

Scroll down to find the correct COM port address. Click the check mark to accept
the changes.

6. Click the yellow Connect button in the lower right corner to establish a connection
to the instrument.
Setting the Instrument Time

The instrument time and the current PC time are shown at the top of the screen when
an instrument is connected to the software.

= _‘1 BI13/2012 BI13/2012
A 111804 AM 1101804 AM

The PC time appears on the left, the instrument time on the right. Both clocks are
updated at 0.5 Hz (once every two seconds). The device time is displayed in red if it
differs by more than a few seconds from the current PC time. Data logging schedules
depend on a correct instrument time.

To synchronize the instrument time to the current PC time, click the Clock Sync button
L@_. Win-Situ writes the current PC time to the instrument.

Adding a New Site
To add a new site to the site database in your working directory do one of the following:
On the Data tab, click the Site Data folder, select File> New > Site.
or

On the Home tab, click the Site button to display the site list, then click New . Enter a
name for the site. This is the only required field.

Click Save to save the new site. The new site will appear in the Site Data folder, and
Win-Situ will add it to the site database in the working directory on your computer. It is
now available to select for any instrument log.

Log Setup

The Log Setup Wizard presents sequential screens to help you supply all the
information necessary to set up a data log in the instrument.

To access the Log Setup Wizard the instrument must be connected to the software.

1. Click the Logging tab | la .
2. Click the New button [ &
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The New button may be disabled or may show a warning if an

v active log already exists on the instrument, or if the instrument is
polling live data (see the Home screen), or if the device already
contains its maximum number of logs.

3. Select the Site where the set of data will be logged and supply a name for the log.
4. Click the right arrow to continue after each step.

5. Select the parameters you intend to measure, choose the measurement units, and
specify the order in which the selected parameters will be logged.

6. Select the logging method you intend to use. See page 52.

7. Select the log interval. A log interval is how often a measurement will be taken and
stored.

8. Select the start condition, stop condition, and specify how to handle full device
memory.

9. Ifyou selected Level or Depth as a parameter to measure, specify how you intend
to log this parameter. See page 53.

10. The final screen summarizes the log setup. Click the check mark to write this
information to the instrument.

Logging Method Descriptions

The following is a list of log types and their descriptions. The log types that are
available on an instrument vary depending upon the capabilities of the instrument.

Logging Methods for Long-Term Monitoring
Linear

Linear log type measures and records at a user-defined fixed interval of one minute or
more. This method is used for long-term studies, landfill monitoring, stream gauging,
tidal studies, and background monitoring prior to aquifer testing. Intervals are measured
in days, hours, or minutes.

Linear Average

Linear Average log type can smooth out anomalous highs and lows that may occurin a
data set, for example, when a water wave passes over the instrument. Each stored
measurement is the average of several rapid measurements. This method is used for
long-term studies, stream gauging, tidal and open-water studies where trends are more
important than accuracy. Intervals are measured in days, hours, minutes, or seconds.

Event

Linear Event log type combines basic fixed-interval logging of specified parameters
with the ability to log data at a faster interval when a single-parameter event condition is
present.
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Logging Methods for Aquifer Testing
True Logarithmic

True Logarithmic log type captures early-time water-level data during aquifer testing.
Measurements are very closely spaced at the start of the test (4 measurements per
second) and move further apart on a logarithmically decaying schedule as the test
progresses. There are 40 measurements per log decade. This log type is commonly
used for rapid step-drawdown pump tests, constant-rate pump tests, and slug tests.

Fast Linear

Fast Linear log type measures and records at a user-defined fixed interval of one
minute or less. The interval is small (seconds, milliseconds), and the test is usually of
short duration due to the volume of data logged and the impact of very fast sampling on
battery life.

Step Linear

Step Linear log type measures and records data according to a number of user-defined
elapsed time intervals or "steps" within a schedule. Both the elapsed time and the
number of measurements within each step can vary. After completing the elapsed time
for each step, the schedule will automatically move to the next step. Up to 10 separate
steps can be defined.

About the Level Reference

A Level Reference, also called an offset, is a user-specified starting point for logged
Level readings. Itis entered in the Logging Setup Wizard when a log is configured, or it
can be stored in the device without configuring a log using the Configure button in the
Sensors tab.

Depth mode does not require that you enter a Level Reference.

The Level Reference can be any value you choose. Here are some examples:

« Elevation—If you calculate the water level above mean sea level (MSL) and enter
this as the Level Reference, then elevations above MSL will be logged.

« Depth to Water—If you measure the depth to the water surface (DTW) from the
top of the well casing and enter this as the Level Reference, then DTW (also
called drawdown) values will be logged.

« Gauge Height or Stage—Logged readings track water level as related to
markings on a nearby staff gauge.

« Zero—A Level Reference of O effectively sets the probe to zero at the start of the
log. Changes, both positive and negative, from the starting water level, will be
logged.

Once you have determined the value of your Level Reference, the software gives you
three options for entering it. These control when the level reference is applied.
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« New Reference—This option is designed to be used with an active software
connection when the device is installed in the water.

A new level reference must be entered while the
device's pressure sensor is submerged in its final
position in the water. This is because the current probe

& reading is set equal to the Level Reference to create the offset
that takes effect at the start of the data log. The log header will
show the probe reading at the time you entered the Level
Reference.

During log setup, the software presents two additional options for entering the Level
Reference:

« Set first logged reading—Use this option when the instrument will be deployed
on wire rather than cable because you will not be able to communicate with the
instrument when it is submerged.

« Remind me to set reference later—Use this option to defer the entry of the
Level Reference during log setup and set a reminder to enter it when the device is
submerged in its final position.

Starting a Log

Every log is programmed for either a manual or a scheduled start. A log with a manual
start time is displayed in the Logging screen with Ready in the Status column. A log
with a scheduled start time is displayed with Pending in the Status column.

Starting a Pending Log

A Pending log automatically starts at the scheduled time without any user intervention.

A scheduled log with Pending status can be manually started at
any time before its scheduled start.

Starting a Manual Log

With the instrument connected to the software, select the Logging tab.
Select the Ready log you want to start.
Click the Start Log button «#. . The log starts and the symbol changes. The Status
column displays Running.
Suspending (Pausing) a Log

A running log may be temporarily paused. For example, you might want to reposition an
instrument, calibrate a sensor, or clean a sensor and later resume the log. A log can be
suspended and resumed three times.
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1. With the instrument connected to the software, select the Logging tab .-'am"": .
2. Selectthe log you intend to suspend.

3. Click the Suspend button Wt/ Suspended appears in the Status column.

o B

Resuming a Suspended Log

1. To resume logging after a log has been suspended, select the Logging tab.
2. Selectthe Suspended log.

3. Click the Start Log button E-E::_. Logging resumes. Running appears in the Status
column. The data file will show the time when the log was suspended and the time
when it restarted.

Stopping a Log

A log can be manually stopped at any time, even if a stop time has been previously
scheduled. If you did not specify a stop condition when you defined the log, the log will
run until the instrument is out of memory or battery power, or until you manually stop it.

A log that has been stopped cannot be resumed. If you intend to
resume a log later, you should suspend a log rather than stop it.

1. To manually stop a log, the instrument must be connected to the software.
2. Selectthe Logging tab . ! ==

3. Select the running log you intend to stop.

4. Click the Stop Log button & .

Downloading Data to a PC

This procedure copies the data log from the instrument to a PC. It does not remove the
data log from the instrument. After a log is downloaded, it can be exported to a CSV file
format that can be used by spreadsheet programs. The time shown in the log name is
the time the log was downloaded.

With an instrument connected, select the Logging tab | &
Select the log you intend to download.
Choose a Running, Suspended, Stopped, or Deleted log.

Click the Download [ ¥’ button.

a k~ wDbd =

In the next screen, select one of the three download options.

o All data

« New data (data logged since the last download)
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« Time interval to download

New data is downloaded by default to a new log file. To append

v new data to the last download of this log, be sure the option
"Append logs on download" is selected in the General Settings
dialog (Preferences > General Settings).

2. The log is copied to the connected PC into your Win-Situ working directory folder.
View or change the working directory using File > Settings.

3. Atthe end of the download, Win-Situ gives you the option of viewing the data.

» Select Yes and the log is displayed in the Data screen.

« Select No and the Logging screen appears. You can view the data
at any time by selecting it in the Data tab.

Viewing Logged Data

1. To view the data stored in the instrument, you must first download the data. A
connection to an instrument is not needed after the data log has been downloaded.

2. Selectthe Datatab | 4 .
3. On the left side of the screen, select the log you want to view. To expand a folder

shown in the navigation tree, double-click the folder. The content of the data log is
displayed on the right side of the screen in text or graph format.

To switch between view formats, click the Text or the Graph
button in the control panel. To customize the text or graph view,

v select Preferences > Graph Settings or Preferences >
Data View Settings. These options apply to all downloaded
data until you change the options.
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Using BaroMerge Software

BaroMerge Software is used to post-correct absolute (non-vented) level sensor data to
eliminate barometric pressure effects from the measurements. BaroMerge Software can
be accessed through the Win-Situ 5 Software Tools menu. BaroMerge provides three
options to correct data.

« Fixed Correction—A single offset value is applied to all selected log data. Use
this option if you know the barometric pressure of the site during the log, and know
that it did not change.

« Manual Entry—Specify two or more correction values to apply to the log data.
Use this option if you wish to manually enter a data set of barometric pressure
values.

« BaroTROLL log file—Absolute level sensor data points are individually corrected

to reflect barometric pressure changes that were logged by a BaroTROLL
instrument during the approximate time period.

x|

BarolMerge™
Select compensation method:

@ Apply a fixed conrection
0 Psi =l

" Enter one or more values manually.

" Use aBaroTROLL file:

BaroMerge Input—BaroTROLL File

Log files that contain absolute data can be barometrically compensated using values
logged by the In-Situ Inc. BaroTROLL Instrument. Select this method when you have
access to a BaroTROLL log file covering approximately the same time period as the

data file you intend to correct.

To use this correction method, you need the name of the BaroTROLL log file and the
name(s) of the absolute log file(s) you want to correct.
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1. From the Tools menu in Win-Situ 5 Software, select Win-Situ BaroMerge.
x|

Barollerge™
Select compensation method:

@ Apply afixed correction:
0 Ps =l

" Enter one or more values manually.

" Use a BaroTROLL file:

s R A )
Select the "Use a BaroTROLL file:" option.

Click the browse button to the right of the file field.

Select a BaroTROLL file and click the check mark.

Values from the BaroTROLL file will be displayed in the next window. You can edit
these values if necessary.

o k& 0D

6. Click the right arrow button.
7. Select the log file(s) you intend to correct and click the check mark.

8. Compensated data files can be viewed or exported from the Data tab.

BaroMerge Output

Your original log file is not changed. A new, corrected log file with the same name and
path is created. The original “.wsl” extension is replaced by “-Baro Merge.wsl".
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Disconnecting an Instrument from the Software

Click the plug icon =@ in the lower-right corner of the screen to disconnect the
instrument from the software.

Disconnect the instrument from the TROLL Com Communication Device. Attach a
desiccant pack if you are using a vented cable.

Connect to a Data Logger or PLC Controller

The instrument can be connected to a data logger or controller via a stripped-and-
tinned RuggedCable System for communication using one of the following protocols.

« Analog (4-20 mA)
o SDI-12
o RS485 Modbus

o RS232 Modbus (with a customer-supplied converter)

Stripped-and-tinned RuggedCable System includes a female connector on one end
that connects to the instrument. The uphole end terminates in stripped-and-tinned wires
for connection to a PLC controller or data logger.

A shorter length Stripped-and-tinned RuggedCable System with a male connector is
available to convert a female to female RuggedCable System to a stripped-and-tinned
configuration.
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PLC or Data Logger
Stripped-and-tinned RuggedCable System with female connector

Short stripped-and-tinned RuggedCable System with male connector

RuggedCable System with female to female twist-lock connector

Q| |WIN|[—~

Instrument
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Wiring

Refer to the diagrams on the following pages for wiring information. Make sure that you
trim and insulate unused wires. The shield must be wired to a chassis ground or earth

ground.

Signal Color Pin

Gnd/Return Black 6

Ext Power Red 5 Y
4-20 mA Brown 4 i F‘; ‘43
RS485(-) Green 3 NFD
RS485(+) Blue 2

SDI-12 White 1
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Analog (4-20 mA) 2 Wire

PLC or Data Logger
4-20 mA BROWN
+ -
- 12-36 VDC
k) Sl ¢—1 GND/RETURN BLACK
|
N

[ B

Level
TROLL
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SDI-12 3 Wire

SDI-12 WHITE

Data Logger EXT PWR RED
9.6-16 VDC

RS485 (-) GREEN
RS485 (+) BLUE

s
T\ GND/RETUBN BLACK

Max. cable length 200 ft

[ BT

SDF12
sensor
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Modbus Master

Digital PLC
12-36 VDC™

EXT PWR RED

=

GND/RETURN BLACK

RS485 (—) GREEN

RS485 (+) BLUE

" Optional but highly recommended

Modbus
Slave

1-800-446-7488
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Modbus Master with RS232 (Converter Required)

Digital PLC EXT PWRRED )
12VDC — | GNDRETUBN BLACK ﬁ
RS232 (TXD) Gnd +12V| RS485(-) GREEN
Rs232 fHXD) R5485 ﬁ'—) BLUE
Converter
" Voltage limited by converter
EXTPWRRED™™"
CONVERTER GND/RETURN BLACK ™™
Port-Powered RS485 converter,
such as B&B Electronics Model e’ . W
ARSI RS485 (-) GREEN
: — Modbus
PIN 5 GND K
aenolt| 8 8| (23555 s
BN 2 RxD |2 2 & E%%E%

"™*Required if port power is not available
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Power Connections

The Red wire provides power for Modbus and SDI-12 modes. The Brown wire provides
power for the 4-20 mA mode. If power is present on the Brown wire and not on the Red
wire, the device enters the 4-20 mA mode automatically and stays in the 4-20 mode
until power is removed from the Brown wire or is applied to the Red wire. The Red wire
has priority. If power is applied to the Red and Brown wires at the same time, the device
will operate in Modbus or SDI-12 modes but not in 4-20.

Communication Protocols

The device automatically switches between Modbus and SDI-12 modes depending on
which of the two interfaces has activity. Modbus and SDI-12 cannot be used at the
same time. The communication protocol that is currently in use will block
communication on the other.

Win-Situ 5 Software provides options for configuring analog/SDI-12 communications
and Modbus communications on the Tools tab.

File Edit View Tools Preferences Help

Level TROLL® 500 5 813
e e =
— Device Information — Device Status
Mame: | Sensor High Power Management:
Manufacture Date: I 4f6/2006 set Mame | Sensor Low s-mms:
Firmware Version: 2.02 Sensor Calibration -
Hardware Version: I i Sensor Malfunction External Power:
Boot Version: I 111 Hardware Reset an
e Device Malfunction :
— Low Battery Dizable Power Management |
10/29/2012 j | 1:12:42PM = St Clodk Low Memary oo Stoe |
— Device Firmware Update
- ) ) Factory Reset
Available Firmware Versions
|Level TROLL S00 v2.02 | gﬁ?ct: Diagnostics |
Analog Setup... I SDI-12 Setup... | Modbus Setup... Alarm Setup... Go Offline |
For additional information on Modbus and SDI-12
& communications, including the SDI-12 commands and Modbus
registers, see www.in-situ.com/Technical_notes and scroll
to the Communications and Software Technical Notes section.
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Redundant Logging

The instrument is capable of internal logging while participating in a Modbus, SDI-12 or
analog network. However, Win-Situ 5 Software cannot communicate with the
instrument while it is transmitting Modbus, SDI-12, or 4-20 mA analog data, and the
instrument cannot receive or respond to Modbus, SDI-12, or 4-20 mA analog
commands while connected to a PC serial port.

If the PLC or data logger loses data, the data that was logged internally on the
instrument can be retrieved using Win-Situ 5 Software.

If the PLC or data logger experiences power loss, the instrument will continue to collect
data using its internal batteries and clock.

A port-powered RS485 converter like that shown for Modbus connections may be used
for temporary connection of the Level TROLL to a serial porton a PC.
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Cleaning and Maintenance

Overview

It is important for users to perform scheduled maintenance on their instruments to
sustain the accuracy and longevity of the probes and cables. The frequency of this
maintenance depends on the characteristics of the deployment site, including humidity
levels and the degree of fouling.

Users should be aware of the conditions at their deployment sites and develop
appropriate maintenance schedules to replace desiccant, clean the instruments, and
send in the instruments for factory calibration. Users should check instruments often
during the first portion of the deployment to determine the frequency of maintenance.
General maintenance should be performed as often as possible. In-Situ Inc.
recommends that you send your instrument in for factory service at least every 12 to 18
months.

Operating Considerations

The instrument has been designed to withstand harsh field conditions. However, as
with any electronic instrument, it can be permanently damaged if used outside its
operating specifications.

Temperature

Review the instrument specifications to determine the operating range. Do not deploy
instruments in such a way that ice may form on or near the sensors or cable
connections. Ice formation is a powerful expansive force that can over-pressurize the
sensor or otherwise cause damage that is not covered by the warranty.

Pressure Range

The instrument can withstand pressures of up to two times (2X) the rated range of the
pressure sensor without damage, although it may not read correctly at such pressure. If
the pressure range is exceeded by 3X, the sensor will be destroyed.

Batteries

Internal batteries in the instrument are not user-replaceable. The approximate
percentage remaining is displayed on the Win-Situ 5 Dashboard when the instrument is
connected in software.

If batteries are completely exhausted, external power and battery pack options are
available. See page 22.
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Desiccant Pack Options
Small Desiccant

The Small Desiccant is a disposable cap that ships with In-Situ Inc. products. The small
desiccant is meant to protect the instrument and cable only during shipping and
should not be used for deployments.

Large Desiccant

The Large Desiccant is a replaceable desiccant pack designed for low-humidity
environments or deployments where maintenance occurs frequently. The large
desiccant is available with a plastic or a titanium twist-lock connector.

{4 =

Description ‘ Part Number
Large Desiccant, Titanium 0051810
Large Desiccant, ABS 0053550

Outboard Desiccant

The Outboard Desiccant is a replaceable desiccant pack designed to attach to the vent
tube of the stripped-and-tinned cable.

Description ‘ Part Number

Outboard Desiccant ‘ 0051380
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Extra Large Desiccant

The Extra Large Desiccant is a replaceable desiccant pack designed for high-humidity
environments or deployments where maintenance occurs infrequently. The extra large
desiccant provides six times the drying capability of the Large Desiccant.

Description ‘ Part Number

Extra Large Desiccant ‘ 0090420

Desiccant Refill Kit

The Desiccant Refill Kit supplies desiccant for the Large Desiccant, Extra Large
Desiccant, and the Outboard Desiccant. It also contains replacement glass wool.

Description ‘ Part Number

Desiccant Refill Kit ‘ 0029140

Installing Desiccant with Twist-Lock Connectors

1. Remove the protective dust cap from the bottom of the desiccant pack, if applicable.

2. Remove expiring desiccant (if present) from the cable by grasping the textured
section of the cable connector in one hand and the desiccant in the other. Twistin
opposite directions to unlock the desiccant from the cable.

3. Attach the new desiccant pack to the twist-lock connector on the cable.
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Installing Outboard Desiccant

Vented cable must be installed with outboard desiccant to protect the cable and
instrument electronics from condensation in high-humidity environments.

The desiccant can be removed from the vent tube, if necessary, to trim the conductor
wires. However, you must reinstall the desiccant after trimming and connecting the
wires.

1. Cut off the knot at the bottom of the vent tube extension.

2. Firmly attach the vent tube extension to the cable vent tube. Cover at least 6.4 mm
(0.25in.) of the cable vent tube for a secure attachment.

3. Use the attached hook-and-loop strap to secure the desiccant to the cable, below
the stripped wires.

4. Remove the red dust cap from the black nylon cap to allow air to reach the cable’s
vent tube.

Outboard desiccant is attached to the
cable vent tube.

Desiccantis secured to the cable with a
strap.

Using the Desiccant Refill Kit

1. Remove the black nylon vent cap from the top of the desiccant.

2. Pourout and discard the used desiccant. Check the glass wool in the bottom of the
container and replace if necessary.

The glass wool prevents the desiccant beads from falling out the

& cable end of the desiccant pack. If the wool glass does this
effectively, there is no need to replace it when refilling the
desiccant.
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3. Fill the container with fresh desiccant. Replace the vent cap. Reattach to cable if
removed.

Antifouling
TROLL Shield Nose Cone

The copper TROLL Shield Nose Cone is designed to reduce macro- and micro-fouling
of the pressure sensor on Level TROLL and Aqua TROLL Instruments. Reduced

fouling on the sensor improves measurement accuracy and extends the length of
deployments.

For optimum performance, the TROLL Shield Nose Cone should be replaced every 12
months or sooner if site conditions are extremely harsh.

w

v\

Description ‘ Part Number

TROLL Shield Nose Cone ‘ 0081480

O-ring Inspection and Replacement

Examine O-rings for wear, dryness, discoloration, stretching, cracks, nicks, and
brittleness. Replace when any of these conditions are present. Replacing O-rings on a

regular schedule, regardless of O-ring condition, is the best way to protect against
damage.

Perform the following steps to replace an O-ring.

1. Remove and discard the damaged O-ring.
2. Use a clean, dry, soft cloth to clean the O-ring groove to remove dirt or residue.
3. Lubricate the new O-ring using high-vacuum grease.

a. Wash your hands thoroughly.

b. Apply a small amount of grease to the pad of your index finger, and
rub your index finger and thumb together to spread the grease
evenly.

c. Inspectthe new O-ring and remove any debris stuck to it.

d. Rub your fingers around the O-ring until there is a thin layer of
grease on the entire O-ring.

4. Install the O-ring in the groove and remove any excess lubricant with a clean cloth.

Do not allow water or lubricant to enter the connector.
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Cleaning and Storage
Cleaning the Instrument

Clean the instrument body with water and a soft brush or plastic scouring pad, or soak
overnightin a mild acidic solution, such as household vinegar. NEVER submerge the
connector portion of the instrument when it is not connected to a cable.

If the ports near the pressure sensor are clogged with silt or mud, try the following
procedures.

« Agitate the instrument vigorously in a bucket of clean water.
« Apply a gentle rinse of water from a wash bottle.

« In severe cases, remove the nose cone and clean out the holes with a soft brush
or pipe cleaner.

Do not attempt to remove material from the instrument by tapping the instrument against
a surface. To avoid damage to the pressure sensor diaphragm, do not insert any object
into the sensor opening or attempt to dig out dirt or other materials. You void the
instrument's warranty by inserting anything into the sensor opening. If
contamination cannot be removed using the recommendations above, please contact
In-Situ Inc. for cleaning.

A TROLL pressure sensor with the nose cone removed. Do not insert ANY object into
the sensor opening. Doing so voids the warranty.

Twist-Lock Connectors

Keep the pins on all connectors free of dirt and moisture by using the soft protective
dust caps when cable is not attached.

Storage

Store the instrumentin a clean, dry place. Place the protective red dust cap on the
cable end or store with cable attached to protect the connector pins and O-ring. Ensure
desiccant is the appropriate size and change it when needed. Store the instrument
where it will not roll off a bench onto a hard surface or sustain other mechanical shock.
Protect the instrument from temperature extremes. Store instruments properly:

o Level TROLL Instruments—store within the temperature range -40° C to +80° C (-
40° F to +176° F)
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Factory Calibration and Service
In-House Factory Calibration

Factory calibration of In-Situ Inc. instruments should be performed every 12 to 18
months, or when the unit data appears to drift significantly. Factory calibration includes
a thorough cleaning, full functionality check, and adjustments of the pressure sensor,
temperature sensor, and conductivity sensor (when applicable) over the entire
calibrated temperature range.

Return Materials Authorization (RMA) Form

To obtain a factory calibration, fill out and return the online Return Materials
Authorization (RMA) form located at www.in-situ.com/Return_authorization.

Obtaining Repair Service

If you suspect your system is malfunctioning and repair is needed, you can help assure
efficient servicing by following these guidelines:

1. Call or email In-Situ Technical Support. Have the product model and serial number
available.

2. Be prepared to describe the problem, including how the product was used and the
conditions noted at the time of the malfunction.

3. If Technical Support determines that service is needed, they will ask your company
to fill out the RMA form and pre-approve a specified monetary amount for repair
charges. When the form and pre-approval is received, Technical Support will assign
an RMA (Return Material Authorization) number.

4. Clean the product as described in the manual.

5. Ifthe product contains a removable battery, remove and retain it unless you are
returning the system for a refund or Technical Support states otherwise.

6. Carefully pack your product in its original shipping box, if possible.
7. Mark the RMA number clearly on the outside of the box.

8. Send the package, shipping prepaid, to:

In-Situ Inc.

ATTN: Repairs

221 East Lincoln Avenue
Fort Collins, CO 80524

The warranty does not cover damage during transit. In-Situ recommends insurance for
all shipments. Warranty repairs will be shipped back prepaid.

Outside the U.S.

Contact your international In-Situ distributor for repair and service information.
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Guidelines for Cleaning Returned Equipment

Please help us protect the health and safety of our employees by cleaning and
decontaminating equipment that has been subjected to potential biological or health
hazards, and labeling such equipment. Unfortunately, we cannot service your
equipment without such notification. Please complete and sign the form on page 76 (or
a similar statement certifying that the equipment has been cleaned and
decontaminated) and send it to us with each instrument.

« We recommend the glassware cleaning product, Alconox, available from In-Situ
and from laboratory supply companies.

« Clean all cables and remove all foreign matter.

« Clean the cable connectors with a clean, dry cloth. Do not submerge the
connectors.

« Clean the instrument including the nosecone, cable head, and protective caps.

If an instrument is returned to our Service Center for repair or
recalibration without a statement that it has been cleaned and

& decontaminated, or if it is the opinion of our Service
Representatives that the equipment presents a potential health or
biological hazard, we reserve the right to withhold service until
proper certification is obtained.
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Decontamination and Cleaning Form

Decontamination & Cleaning Statement

Company Name Phone
Address

City State Zip
Instrument Type Serial Number

Contaminant(s) (if known)

Decontamination procedure(s) used

Cleaning verified by Title

Date

@ In-Situinc.
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Troubleshooting

In addition to the following troubleshooting items, the In-Situ Inc. website includes
instructional videos, technical notes, and more. See www.in-situ.com/resources.

Problem

Possible Cause

Possible Solution

Win-Situ 5 Software cannot
connect to the instrument.

Wrong COM portis selected,
communication settings are incompatible,
cable connections are loose or dirty, or
batteries are low.

Make sure cable connections are tight and
connectors are clean and dry.

Make sure the cable is securely attached to the
instrument.

Make sure the correct COM port is selected (select
Preferences > Comm Settings to verify).

Make sure the communication settings in Win-Situ
and in the instrument match. To reset the device
communication settings to the serial defaults, click
“Reset all Devices” in the Comm Settings dialog
(Preferences > Comm Settings).

Make sure the internal battery has voltage
remaining, or external power is supplied.

See www.in-situ.com/Technical_notes and scroll
to the Communications and Software Technical
Notes section for more information.

Real-time readings display the
wrong units.

Default units are being used.

Click the Sensors tab, select the sensor, click the
configure button and select the desired units for
each parameter in the Sensor Setup window.

Cannotadd a new log.

Only one active log can reside in the
device ata time—an active log is a log
that is Ready, Pending, Running, or
Suspended as shown in the Status
column of the Logging Tab.

The device has its maximum number of
logs already stored—the Level TROLL
300, 500, and Baro TROLL have a
capacity of 2 logs.

Stop or delete the log if possible. Alternatively,
configure the new log after the active log is
completed.

Download, and then delete a log you no longer
need. This will make room for an additional log on
the device.

New log exceeds available
memory (software message).

The log as configured would exceed the
device memory.

Edit the log and select a longer sampling interval.

If available, select the "wrap data" option. This
causes more recent data to overwrite older data
when memory is full.

For a log with a scheduled start, select None as the
stop condition, or select a stop time that is closer to
the starttime.
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Problem

Possible Cause

Possible Solution

Cannot configure level or other
parameters using the Configure
button on the Sensors tab. The
Sensor Setup screen is shown, but
the Configure... button is dim.

The instrument is actively polling
(continually updating real-time readings)
in the Home tab.

The instrument has an active log—a log
thatis Ready, Pending, Running, or
Suspended as shown in the Status
column of the Logging tab. Only one
active log can reside in the device ata

time.

Return to the Home tab and stop real-time
readings by clicking the Play button.

Stop or delete the log if possible. Alternatively,
configure parameters after the log is complete.
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Declarations of Conformity and Similarity

Level TROLL 400 Instrument

EMC Verification
Declaration of Similarity

Equipment
Type of equipment: Measurement instrumentation
Product name: Level TROLL® 400
Model: Level TROLL® 400
Manufacturer: In-Situ, Inc.

221 East Lincoln Avenue

Fort Collins, CO 80524

USA
Category Standards
Emission: EN 61326 & FCC Part 15, Subpart B
Immunity: ENG1326
Summary

We confirm that the equipment referenced above, without reasonable doubt, will fulfill the

requirements concerning electromagnetic compatibility according to the above mentioned
standards harmonized with the EMC Directive 89/336/EEC. The Level TROLL 700 was tested
and found to be in compliance in the month of January 2008.

Date of Issue: August 30, 2013

(B, psL =

Ben Kimbell
Vice President of Research and Development
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Level TROLL 500 Instrument

Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: Level TROLL

Model: Level TROLL 500

Product Description: The Level TROLL measures and logs level and temperature in natural
groundwater and surface water.

is in compliance with the following Directives:

B9/336/EEC for Electromagnetic Compatibility (EMC) Directive
T3/23/EEC for Safety Directive

and meets or exceeds the following international requirements and compliance standards:

+ Immunity
EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

+ Emissions
Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control
and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE
mark is affixed accordingly.

Tl (el

Todd Campbell
New Product Development Program Manager

In-Situ, Inc.
January 17, 2006 C
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Level TROLL 700 Instrument

Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: Level TROLL

Model: Level TROLL 700

Product Description: The Level TROLL measures and logs level and temperature in natural
groundwater and surface water.

is iIn compliance with the following Directives:

B9/336/EEC for Electromagnetic Compatibility (EMC) Directive
T3/23/EEC for Safety Directive

and meets or exceeds the following international requirements and compliance standards:

+ Immunity
EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

+ Emissions
Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control
and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 8B9/336/EEC and 73/23/EEC, and the CE
mark is affixed accordingly.

T Coplell

Todd Campbell
New Product Development Program Manager

In-Situ, Inc.
January 17, 2006 C
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TROLL Com Communication Device

Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: TROLL Com
Madel: USB TROLL Com
Product Description: RS485 to USB converter

is in compliance with the following Directive

89/336/EEC for Electromagnetic Compatibility (EMC) Directive
T323/EEC for Safety Directive

and meets or exceeds the following international requirements and compliance standards:

+ Immunity
EN 61326, Electrical Equipment for Measurement, Control and Labeoratory Use, Industrial
Location

+ Emissions
Class A requirements of EN 61326, Electrical Equipment for Measurement, Control and
Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE
mark is affixed accordingly.

Tl Coplell

Todd Campbell
New Product Development Program Manager

In-Situ, Inc.
June 17, 2006 ( G F@
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BaroTROLL Instrument

Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: Level TROLL
Product name: Baro TROLL
Product Description: The Baro TROLL measures and logs barometric pressure and temperature.

is in compliance with the following Directives:

89/336/EEC for Electromagnetic Compatibility (EMC) Directive
T3/23/EEC for Safety Directive

and meets or exceeds the following international requirements and compliance standards:

o  Immunity
EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

+ Emissions
Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Contral
and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE
mark is affixed accordingly.

Tood (gl

Todd Campbell
New Product Development Program Manager

In-Situ, Inc.
January 17, 2006 c e @
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